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Before you start 

Welcome to Foundations in Music. This course is designed to help you develop as a composer, 

musician, or music appreciator. It will give you a firm grounding in many aspects of this  

multi-faceted subject including music theory, basic composition and arrangement, ear training 

and music history. You will also develop skills in the use of the notation software Sibelius, which 

is integral to the course. 

Whether you are starting completely from scratch or identifying gaps in your knowledge and 

topping up your skills, our Foundation Course is designed to give you a well-rounded basic 

music education, taking an approach from beginner/novice through to higher education ready. 

This course is suitable for students who are unsure whether they are ready to engage in degree 

level study and require a re-introduction to the subject, or to those who wish to study a single 

stand-alone course to develop their skills and understanding. 

During the course you will learn music theory to around Grade 5 standard (ABRSM/TCL) 

and utilise this knowledge practically in a range of tasks, which include an introduction 

to composition. You will also learn how to start researching and writing about music in an 

academic style, with personalised guidance from your tutor. The course will help you to learn 

independently and to critically reflect on your listening and learning experiences. 

On completion of the course your tutor will help you judge whether you have gained sufficient 

skills and enough confidence to go on to further study at HE level with the Open College of the 

Arts, or elsewhere, and be able to decide on the nature and direction of your studies or musical 

practice. 

You’ll find more information about studying with OCA in your Student Handbook so keep this 

to hand as you work through the course

If you haven’t already done so, now is a good time to work through the free introductory course 

‘An Introduction to Studying in HE’. This is available on the OCA student website. 

Don’t be tempted to skip this introductory course as it contains valuable advice on study skills 

(e.g. reading, note-taking), research methods and academic conventions which will stand you in 

good stead throughout your studies.

The OCA website will be a key resource for you during your studies with OCA, so take some 

time to familiarise yourself with it. Log onto the OCA student website and find the video guide 

to using the website. Watch the video and take some notes. 

Remember, there are other students following this course, so you are not on your own. Use the 

online forums to reflect on your findings and discuss issues with other students.
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Course aims 
The course aims to:

• familiarise you with the language, history and terminology of music 

• develop a solid knowledge of music theory and its practical application

• introduce methods of composing and arranging music

• explore and utilise Sibelius notation software

• encourage and develop independent learning and research skills in order to prepare you 

for successful transition to undergraduate degree level study

Learning outcomes
When you’ve completed the course, you should be able to: 

• demonstrate an understanding of the main historical periods of music history (c.700-

1950) and be able to reflect upon the work of established composers and the relevant 

terminology. 

• demonstrate an understanding of music theory to c.Grade 5 (ABRSM/TCL) and apply this 

knowledge to practical tasks

• demonstrate techniques to manipulate and compose music

• demonstrate an ability to typeset music clearly within Sibelius notation software

• demonstrate an ability to independently research a subject and write about it critically in an 

appropriate academic style

Your tutor
Your tutor is your main point of contact with OCA and will give you support and feedback 

through the course, primarily through the five marked assignments. Contact with your tutor will 

be via email, and you can get in touch at any time if you have questions about the course or if 

you are stuck. 

Your tutor’s contact details are in the course pack. If you haven’t already done so, please 

introduce yourself to your tutor with a paragraph or two about your experience to date. Add 

background information about anything that you think may be relevant for your tutor to know 

about you (your profile) – for example your background and any experience of music so far, 

your reasons for starting this course and what you hope or expect to achieve from it. Email or 

post your profile to your tutor as soon as possible. This will help him or her understand how 

best to support you during the course.

When you email work to your tutor, make sure it is clearly labelled with your name, student 

number and the assignment number. Your tutor will provide constructive feedback to you as 

soon as possible after receiving your assignment, usually within 2 weeks. Your tutor reports may 

also include suggestions for further reading and listening, advice on how to proceed and advice 

to help you progress. While you’re waiting for your report to arrive, you can continue working 

through the next part of the course.



7   Foundations Music

Note that you’re encouraged to reflect carefully on feedback and, if appropriate, to go back to 

the assignment you submitted and make adjustments to it based on your tutor’s comments. 

The OCA tuition system is explained in some detail in your Student Handbook should you 

require further information.

Although you are working from home at your own pace, you can also draw on support from 

fellow students. The OCA website forums are an ideal place to meet other OCA students, both in 

music and other subjects, share experiences and learn from each other. These can be accessed 

via the OCA student website.

Your listening and learning log
Your listening and learning log is an integral element of every OCA music course. It can be used 

in the manner of a personal scrapbook of ideas and learning. Your log will be checked on a 

regular basis by your tutor to help guide and personalise your learning. If this is your first course 

with OCA, you’ll find guidance on what to include in your log and how to set up an online 

learning log/blog on the OCA student website.  

Your logs are where you will bring together critical reflections of the music you’ve heard, your 

research on composers, repertoire and other aspects of music and your personal reflections 

on the course, your work and your progress. Here you can also begin practicing the use of 

academic writing conventions, including referencing,  if you quote other writers. 

You’re strongly recommended to use an online log or blog instead of (or in addition to) a 

physical learning log. A blog is a great way to consolidate and present your work, findings, 

observations and reflections for your tutor and peers to review. You can also include links to 

new research sources you’ve found so that these are available to your fellow students.

Setting up a blog is free and can be done through websites such as Blogger, Tumblr or 

Wordpress. On the OCA student website you can find templates to help you set up your log. 

Plan ahead
This course represents around 400 hours of learning time. Allow around 20% of this time for 

reflection and keeping your writing diary. The course should take about a year to complete if 

you spend around 8 hours each week on it. 

As with all OCA courses, these course materials are intended to be used flexibly but keep your 

tutor fully informed about your progress. 

Foundations in Music is divided into five parts, corresponding to the five course assignments. 

The first assignment will enable your tutor to get to know you, review your work so far and 

decide how best to help you in the future.
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Reading and listening
A suggested listening list for the course can be found in Appendix A at the end of this course. 

Record your thoughts, reactions and critical reflections on your listening in your learning log; 

this will be helpful when you come to reflect on your progress. 

Referencing your reading
Whenever you read something that you might want to refer to in your projects and 

assignments, get into the habit of taking down the full reference to the book, article or website 

straight away. Although it is not a requirement of this course, if you continue on to formal 

degree level study, the use of academic writing conventions is mandatory.

At the OCA we use the Harvard system of referencing – see the Harvard referencing system 

guide on the OCA website for a detailed explanation.

Specialist musical terms
Specialist musical terms are shown in bold throughout the course. Some of these can be found 

in the glossary. Include definitions of any others that you are unfamiliar with in your learning 

log.
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Course structure

Each part of the course includes elements of the following core strands:

1. Music Theory & Ear Training - the language and grammar of music 

2. Music Composition - the art of writing music and expressing your ideas

3. Typesetting and Publishing Techniques - how to use the Sibelius notation program

4. Historical Contexts - musical periods, instruments and composers 

5. Special Subject Investigation - A personalised academic investigation, to be agreed with 

your tutor, gradually producing an academic essay.

The five strands appear in each of the five parts of the course, enabling you to combine your 

skills in each of these areas. The course is divided into five parts, each of which culminates  

in an assignment which you’ll send to your tutor for review. A number of projects and practical 

exercises are also included in each section of the course. 

Take note of the suggested date (on your tutor reports) for your next assignment but don’t feel 

pressurised. These course materials are intended to be used flexibly. Work at a pace that fits in 

with your life. If you feel you can complete a particular part of the course quickly, then by all 

means do so. If you feel you need a little longer, that’s fine. However, if there’s going to be a 

considerable delay (e.g. several months) between assignments, contact your tutor and let them 

know what’s happening. 

Making a start
Start by skimming through the course guide to get a feel for the way you’ll work. Don’t feel you 

need to read every detail at this stage; this is just a chance to get your bearings. Once you’ve 

done this, contact your tutor (see above) and think about what equipment you’ll need. 

Work through the course in the order it’s written. Read the first part of the course thoroughly 

and ensure you have everything in place before starting. It’s a good idea to read each section 

several times before you start work so you know exactly what you’re supposed to be doing.

Software required
For this course you will need to purchase and install Avid Sibelius. There are two versions of this 

program, the full version and Sibelius First. The latter is a cut-down version for students which is 

available at a cheaper price than the full program. Sibelius First will be adequate for this course, 

but should you continue on to degree level study it is recommended that you upgrade to the 

full version. There are many features in the full version which are not available in Sibelius First. 

This course has been written using the latest version of Sibelius.

The full version is available at a discount for students in a package called ‘Sibelius for Education’ 

and can be purchased outright with an annual upgrade plan or licensed on a monthly 

subscription basis. Full details can be found at www.sibelius.com. Sibelius is available by 

download or in physical format from a number of websites and music shops. 

Sibelius is a powerful notation program which allows you to create full, customisable scores and 

parts, and also offers some audio playback. Sibelius has extensive support and help features 

with a multitude of guides and video tutorials.



10   Foundations Music



11   Foundations Music

Foundations Music

Part one

Carla Rees, Clavichord
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Introduction

Western Art Music (or Classical Music, as it is also sometimes called) is a genre of music 

which spans a tradition of several hundred years, from the music of Medieval times to 

the contemporary music of today. As this music has developed over time, stylistic trends 

have emerged, flourished and evolved, leaving us with a vast wealth of repertoire for all 

combinations of instruments and voices, from solos to works for orchestra, choir, and even 

electronics. The field of Western Art Music is enormous, and even the most established 

professional musicians cannot hope to know every single piece; in this course you are 

embarking on a journey of discovery, in which you will find some familiar repertoire as well as 

new areas for exploration.  You will learn to read and write music, though a system of notation 

that has also developed across the last centuries, and you will gain an understanding of the 

three main ‘pillars’ on which music is formed: rhythm, pitch and harmony.

You do not need to be able to play a musical instrument in order to follow this course, but 

you may find you are inspired to begin learning one (if you don’t already). Practical music-

making can be an enormously enjoyable activity, and joining an ensemble or choir can be 

an excellent way of meeting other like-minded people who share your interests in music. 

There are numerous organisations that cater for all levels of skill; if you need advice in finding 

opportunities or teachers in your area, ask your tutor for help, or contact an organization such 

as Making Music, the Incorporated Society of Musicians or the Musicians’ Union. 

Reading Music
Written music is a combination of symbols, signs and text which represent sound and the 

mood and character of the music. Musical notation is generally logical, but it can take some 

time to get used to all of the signs and symbols and to understand what they all mean. Like 

any skill, taking time to practice will help you become more fluent. When you listen to music, 

try to locate a copy of the score online to look at as you listen. To begin with, it is unlikely that 

you will be able to follow the score in detail, but you may begin to notice particular features as 

they become more familiar to you. With all the theoretical aspects of this course, there are many 

online resources you can consult for more explanation or further examples. Remember too, 

that your tutor is there to help you and can explain anything that remains unclear. With each 

new concept, try to look at scores and find examples. Online score libraries, such as IMSLP hold 

a wealth of examples for you to look at and explore. Be patient in your music reading journey, 

and get as much practice as you can. Before long, music notation will look a little less like 

hieroglyphics and you’ll begin to imagine the sound of the music you’re reading.
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Music history

During this course you will begin to explore the development of Western Art Music throughout 

history from the early Medieval through to the middle of the Twentieth Century, and will have 

an opportunity to listen to music by some important composers and their contributions to the 

development of music. 

After completing this course, should you continue on to the OCA’s music degree pathway, you 

will approach musical history subject matter again in the Level 1 course From the Present to the 

Past, a unit which explores each musical period in detail working backwards through history 

from the present day; a compelling and interesting direction of study. 

Caveman in Mask with Fire (colour litho), D’Achille, Gino (20th century) 

Private Collection Bridgeman Images
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Musical beginnings
Music has been around since the beginnings of human existence, with sound created through 

non-verbal uses of the voice, as well as with primitive instruments. One of the earliest known 

musical instruments is a bone flute, known as the Divje Babe Flute, found in Slovenia in 1995. 

This flute is thought to be over 41,000 years old, and other similar examples have been found in 

Germany.

Over time, music came to be used for various roles, including entertainment, ritual, religious 

ceremony, incantations, dance, work, war and passing messages.  As the world changes, so does 

our use for music. Think about the way music is used today; can you think of uses that would 

not have been prevalent 50 or 100 years ago?

Flute, City of David (bone), Jewish School, Private Collection 

Photo © Zev Radovan, Bridgeman Images
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The historical periods of music
For easy classification, the history of music is divided into periods, in a similar way to other arts 

and historical subjects.  Each era has a set of characteristics which developed according to the 

prevalent ideologies and styles, and the periods of music history often relate closely to those of 

literature and painting. 

Alongside the evolution of ideas, stylistic developments in music often went hand in hand 

with advancements in musical instrument technology. This often resulted in changes of 

compositional style as restrictions imposed by instrumental techniques were gradually 

removed. For example, major changes in instrument design, such as the dynamic capabilities of 

the piano, or the addition of keys and valves to woodwind and brass instruments respectively 

had a dramatic impact on the sort of music that could be performed with a level of practical 

success.

Through this unit you will begin to get a sense of the stylistic differences between periods 

and you will be able to explore the music of each era through your own listening. Suggested 

listening lists and links to online playlists can be found in Appendix A as a starting point for 

your own explorations.

Important note: The listening lists in Appendix A are for guidance and suggestion only. 

They are not exhaustive and you are not expected to listen to every one of the examples 

all the way through. They are a guide and for those that are interested in following up 

composers’ work.  However, students are advised to try to listen to at least an excerpt 

from each composer so that an idea of style can be assessed and put into context. 

Remember to include notes about the music you listen to in your Listening and Learning 

Log.

Research point 1
Through your own research, try to find approximate dates for each of the main historical 

periods of music. These are:

Medieval, Renaissance, Baroque, Classical, and Twentieth Century

You may find there is some overlap between the different eras, and that different sources 

state slightly different dates. Consult a range of sources and use your judgment to come up 

with your guideline dates.

Make a list of your sources (including the page numbers of any books you used and the 

date of access of any websites) in your learning log.
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Medieval Music 

Religious music in the Medieval 
Period

Notated music, in the form that we know 

it today, has its origins in the music of the 

Medieval era (c700-c1450). At that time, 

the main use for music was religious, and 

unaccompanied melodic lines, called 

plainchant or Gregorian Chant, set sacred 

(usually Latin) texts to music. The rhythms 

came mostly from the natural rhythms of the 

text, and elaborately decorated manuscripts 

presented the texts with an early form of 

melodic notation.

An example of a score from this era, by 

Hildegard von Bingen, can be seen here:

Link 1. Please note the that list of Links are at 

the back of your course book, or you can find 

them on the student site in course resources. 

They are listed separately on this sheet for ease 

of updating. 

Medieval music was built on modes, sets of pitches that were the pre-cursor to modern 

scales. Over a period of 200 to 300 years, single line plainchant began to be harmonised with 

organum, parallel melodies that followed the same contours but beginning on higher or lower 

notes. As time moved on the music began to develop into a more complex form with freer lines 

of melody written around a cantus firmus (fixed melody), which was the original plainchant 

line. Very often these melodies were very well known to the congregation, having been passed 

on in an oral tradition, and were therefore kept stable, usually sung by the Tenor of the choir, 

while the other parts embellished it. This became known as the Ars Antiqua (the music of the 

13th century).

The Ars Nova was a new approach to composition which emerged in around 1310, and the 

term is sometimes used to describe all polyphonic (many lines of music sounding together) 

music from Europe in the 1300s. During this time, notation developed which allowed for a 

greater sense of rhythmic freedom between the parts. This led to the development of new 

forms of composition, such as the motet, virelais and ballade.

Some important composers of this period were: Kassia of Constantinople, the first known 

composer with an extant piece of music to her name that has survived the rigours of history; 

the theologian, philosopher and Abbess Hildegard von Bingen; Léonin, Pérotin and 

Guillaume de Machaut.

Presentation of Jesus at the Temple

Bibliotheque Municipale, Laon, France, 

Bridgeman Images
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Instruments in the Medieval Period
Outside of the church, the ability to read and 

write music was not widespread and secular 

music of the Medieval era was rarely notated. 

As a result, the music was passed on through 

oral traditions and much of it has now been 

lost. However, there is evidence of songs and 

music for dance, and images of music- making 

from art works of the time can also be helpful 

as a way of gaining insight about the musical 

life of the era.

Political events and changes of national 

boundaries had an impact on the music of the 

era, with influences coming from abroad with 

each new ruling class. This can be witnessed 

through changing popularity of instruments. 

For example, in Britain the Anglo Saxon Lyre 

was superseded by the French troubadour 

harp, as a result of the Norman Conquest in 

England (1066) and the intentional change of 

the native culture by the new rulers.

Troubadours and trouvères were travelling 

minstrels who went from court to court to entertain through song and storytelling. They were 

the professional musicians of the time, introducing their instruments, ideologies of chivalry 

and courtly love, and musical influences across Europe.  Other terms for similar musicians in 

different parts of Europe are bards, jongleurs, minnesinger, skalds or scops (pron. shops). Two 

well-known minstrels of the time were Adam de la Halle and Bernard de Ventadorn.

Page and Troubadour of the 13th century, 

French School, (19th century) 

Private Collection © Look and Learn, 

Bridgeman Images
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Research point 2: Analytical listening
As you begin to explore the music in the listening lists and through your own research, it is 

time to develop an analytical and critical approach to the music you are hearing. This will 

help you to gain a deeper insight into the music and learn from how it is constructed. To 

begin with, you do not need to include technical terms in your listening log entries; just use 

whatever language you feel most comfortable with. As you listen, make notes on questions 

like those listed below, and on anything else that attracts your attention in the music:

• How would you describe the music to someone who hasn’t heard it?

• Is it fast or slow?

• Is it loud or quiet?

• What sorts of sounds are used?

• Is the music for voices or instruments or a combination of both? 

• How many instrumental/voice parts are there? 

• Does it have a melody and accompaniment, or a solo line, or lots of parts weaving 

together?

• If it uses voices, what is the text?

• Is it religious or secular? 

• Make notes on anything you find interesting or surprising about this music. 

• Do you like it? Why?

• How does it make you feel?

• Does it remind you of any other music you’ve heard?

• Is it consonant or dissonant?

• What elements does it have in common with other pieces from the same era?

• Is there anything you don’t like about this music? Why?

Choose three composers from the Medieval era. Write short biographical notes on each 

one and listen to examples of their work.  Write a paragraph in your listening and learning 

log about each example. Give a personal reflection on your impressions of the music of the 

Medieval era.

Remember to keep a list of any references used.
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Project 1 A Medieval Timeline

This project is in two parts.  

Part one
As you work through the course, gradually put together a timeline of the historical eras. Include 

major social or historical events for context, as well as the dates of major composers and works 

from each era. You can do this in any format you like, but a horizontal timeline is shown below 

as a suggestion. Fill in the information for the Medieval era, based on your own research.

700           1450
Example of basic timeline

Part two
The list below includes some of the instruments used in the Medieval period.  Choose any four, 

and write a brief description of the instrument, what it may have looked like, what it might have 

sounded like, and in what situation it may have been used in this period.

Pipe and Tabor Anglo Saxon Lyre Troubadour Harp Lute

Cornett Shawm Cornu Psaltery

Citole Rebec Portative Organ Hurdy Gurdy

Bagpipe Sackbut Horn Symphonia

Musical notation: rhythm
Rhythm is one of the building blocks of music. It is the vital element that makes us want to 

dance, or march, or tap a finger, hand or foot along to the beat of the music. A regular pulse can 

be represented through the use of a one-beat note, the crotchet:

Like footsteps left right left right

♪ ♪ ♪ ♪
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In notated music, each note value has its own symbol. Some of these are shown below:

The American system of note naming, included here for reference, calls the semibreve a whole 

note, and all other values are expressed in relation to this, so the American name for a minim 

is a half note, and a crotchet is a quarter note. This can be useful as a way of remembering the 

mathematical relationships between the durations.

Help during the course
During the course, you may also find it very 

helpful to access help and guidance materials 

provided by Sibelius. These can be accessed 

from the Learn tab of the Quick Start menu 

or the Help option on the File menu within 

the main program (shown right) and include 

tutorials, guides and introductory help 

videos.

1            1             1            1

1            2             3            4

1            2             1            2

Crotchet (Quarter note) = 1 crotchet beat

Minim (Half note) = 2 crotchet beats

Semibreve (Whole note) = 4 crotchet beats

˙

œ

w

œ

˙

œ œ

Exercise 1 Opening and Exploring Sibelius
Now is the time to start using Sibelius. For help installing the software, advice can be found 

in the Sibelius forums here: Link 2.
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Open Example1.sib (found in the course resources) in Sibelius. You should see something as 

below. 

This is a rhythm for snare drum and, as it is an unpitched instrument, it is written for on a single 

line. Follow the note types along the line, tapping out the rhythm whilst counting the number 

of beats. 

Use the functions on the Play tab to hear a playback of the rhythm. Use the reset button (left 

facing arrow with a vertical line) to make sure the green playback line is at the beginning, and 

press play. Try to clap the rhythm in time with the playback.

OCA Foundation Music: Example 1

Snare Drum / œ œ œ œ œ œ œ œ ˙ ˙ ˙ ˙ w w

Tip
For an explanation of each button on Sibelius, and to discover the keyboard shortcuts, 

hover the arrow/pointer over each function (eg play, stop, reset etc.) Also note the click (or 

metronome) button, which is circled on the picture below in RED. This will allow you to hear 

the beats whilst you are counting along.

The play, stop, rewind and reset functions on the ‘Play’ tab of Sibelius
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You are now ready to compose your own rhythm. Using the example as a starting point, 

change the note values. To do this, click on any of the notes and select either a crotchet, minim 

or semibreve on the Keypad (shown right and circled). Experiment, change things, see what 

happens to the notation and what subsequently happens to the playback. 

Bars, Barlines and Time Signatures
To organise note values into clearly readable units, vertical lines are inserted in between groups 

of notes. These lines are called barlines, and they group notes together into bars. A bar may 

contain any number of beats, but it is most common to see bar lengths of 2, 3 or 4 beats. The 

first beat of the bar is usually a little stronger than the rest (think of the distinctive rhythm of a 

Waltz, for example, with a strong first beat and two lighter ones) and a composer chooses the 

number of beats in each bar according to the emphasis he or she wishes to create.

In order to define how many beats appear in each group, a time signature is used at the 

beginning of each piece, and before any subsequent change of groupings. The time signature 

is made up of two numbers; the top number shows how many beats are in each bar, while the 

bottom number shows what kind of beats they are. The number 4 at the bottom represents 

crotchet beats (the American system of note naming can help to make sense of this), as in the 

examples below:

= 2 crotchet beats in a bar

= 3 crotchet beats in a bar 

= 4 crotchet beats in a bar

Tip
If you cannot see the keypad, you can also 

turn it on/off via View > Panels > Keypad.
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Let’s look back at the snare drum example, this time with the time signature and bar lines 

included:

 

The time signature here is four-four (4/4), meaning four crotchet beats in a bar, and you can see 

that each bar clearly adds up to four beats. 

OCA Foundations Music: Example 1

Snare Drum
4
4/ œ œ œ œ œ œ œ œ ˙ ˙ ˙ ˙ w w

Example 1a

Tip
Bars are usually numbered within a piece of music so that they can be used as a point of 

reference. The bar numbers are often found on the left hand side of the line of music, or 

sometimes above the line. 
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Example 2, below, shows music in each of the time signatures discussed above. Audio files can 

be found in the course materials. Listen to each and notice the stress on the first beat of each 

bar.

Four beats in a bar (quadruple time) is perhaps the most commonly found time signature, 

particularly in popular music, whilst three beats in a bar (triple time) is often used in music for 

dances, such as waltzes and minuets. Two beats in a bar (duple time) in often used for music like 

marches. 

Ex 2

1 2 3 4 1 2 3 4 1 2 3 4

Ex 2

1 2 3 1 2 3 1 2 3 1 2 3

Ex 2

1 2 1 2 1 2 1 2 1 2 1 2

4
4

3
4

2
4

/a

/b

/c

œ œ œ œ œ œ œ œ œ œ œ œ

œ œ œ œ œ œ œ œ œ œ œ œ

œ œ œ œ œ œ œ œ œ œ œ œ

Example 2 a-c

Exercise 2 Ear Training
Listen to Examples 3a, 3b and 3c in the Audio Files.

• Example 3a is in duple time, feel the 2 beats in the bar (Strong - Weak)

• Example 3b is in triple time, feel the 3 beats in the bar (Strong - Weak - Weak)

• Example 3c is in quadruple time, feel the 4 beats in the bar (Strong - Weak - Medium - 

Weak)

Now listen to Examples 4a, 4b and 4c. Try to work out which is which. The answers can be 

found on Page 50. 
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More rhythms Quavers and Semiquavers
There are also time values that are shorter than crotchets. A quaver lasts for half the length of a 

crotchet and a semiquaver for a quarter of the length of a crotchet.

Exercise 3 Listening and Reflection
Use your own music collection or an online service, such as Spotify or Youtube, to listen to 

some of the pieces of music listed below. See if you can identify whether they are written in 

duple, triple or quadruple time. Make notes in your listening and learning and then check 

your answers against those given on page 50. 

• ‘Tritsch Tratsch Polka’ (Johann Strauss)

• ‘Sarabande in D minor’ HWV 437 (Handel)

• ‘The Sailor’s Hornpipe’ (Trad.)

• ‘We Will Rock You’ (Queen)

• ‘Feed the Birds’  (from Mary Poppins)

• ‘Finale from William Tell Overture’ (Rossini)

• ‘Libertango’ (Astor Piazzolla)

• ‘The Times They Are A-Changin’ (Bob Dylan)

• ‘In the Hall of the Mountain King’ Op.46 (Grieg)

Once you know the answers, listen again and see how clearly you can feel the pulse. Make 

some reflective notes in your log – were the answers as you expected? Did your perception 

of the music change once you knew the answers? How easy or difficult was this exercise for 

you?
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Beaming
Example 5a below shows what three bars of four-four look like if filled with individual crotchets, 

quavers and semiquavers. An audio of this example can be found in the course materials; listen 

to the notes halving in value with each subsequent bar.  

 

When the notes are written out individually like this, it can be difficult to keep track of how 

many repetitions of each kind of note value there are. To make reading easier, it is usual for 

groups of quavers, semiquavers and even faster notes to be beamed together into beats. In the 

example below, it can clearly be seen that two quavers joined together make up one beat, and 

so do four semiquavers. In each bar, the four main beat groups are immediately visible:

Example 5b can be found as a Sibelius file in the course materials. Play through the example 

following the subdivision of beats, imagine attaching words of the same number of syllables to 

each group, perhaps Thames for the crotchets, Danube for the quavers and Mississippi for the 

semiquavers, as this can often help. 

Example 5a

Example 5b
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1

1  Taylor, E. (1989) The AB Guide to Music Theory - Part 1. Amersham: Associated Board.

Exercise 4 Beaming

Open Example 6 in Sibelius and use the options on the ‘beaming’ 

tab of the keypad (highlighted in red) to correctly beam the rhythm 

into groups of beats. Remember that hovering the pointer over the 

different buttons brings up a description.  

Sibelius often automatically beams the notes for you, but it is 

important to learn how to manually change the beaming using the 

appropriate buttons (Right: circled in red). After you have finished 

check your answer against the one given on page 50.

Example 6

Tip
More information about time signatures 

and beaming can be found in Chapter 1 

of The AB Guide to Music Theory - Part 11
 

which is highly recommended as a study 

resource for the whole course.
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Pitch
The human voice is usually the first contact 

we have with musical pitch; by singing 

a nursery rhymes as children we quickly 

develop a natural experience of a range 

of notes, both low and high. Pitch is a 

description of how high or how low a note 

is, and can be shown either through musical 

notation or even described precisely by its 

frequency, measured in Hertz. 

In musical notation, each note has its own name, based on the first 7 letters of the alphabet, A 

to G.

A - B - C - D - E - F - G

Instead of proceeding to H, I and J, the musical alphabet then repeats itself:

A - B - C - D - E - F - G - A - B - C - D - E - F - G - A- B - C (etc.)

Marie Hugo, Zoe Chante I, 1993 (tempera 

on wood) (Contemporary Artist)

Private Collection, Bridgeman Images

Tip
Although this scientific identification 

of pitch lies outside of the scope of this 

course, a detailed introduction may be 

found here: Link 3
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Each repetition of the pattern (so for example, from the first A to the second one) is known as 

an octave.

This can be shown using the layout of a piano or keyboard, where the repeating pattern is 

easier to identify. Notice that each time the pattern of notes repeats, it corresponds with the 

repeating layout of the keyboard, so for example, every C is placed to the left of a group of 2 

black notes, and every F is placed to the left of a group of three black notes:

Tip
An awareness of the positions of notes on the piano keyboard can be useful, especially 

when dealing with the theoretical aspects of music. There are number of online quizzes 

which can help you, such as this one - Link 4
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Staves and clefs
Notated music gives a graphic representation of these notes on a five line stave or staff, with 

notes drawn either on a line or in the space between them. Think of the stave like a ladder; the 

notes get higher in pitch the further up the stave they are placed:

Lower          Higher

Each stave allows for a relatively wide range of pitches, but cannot include the whole range 

found between, for example, the lowest and highest notes of the piano. To solve this problem, 

different clefs are used to indicate how high or low the notes are. The two most common types 

of clef are the treble clef and the bass clef.

The treble clef is used for high-pitched material, such as the right hand 

of the piano, instruments such as the flute or violin, and female voices. 

It is a form of G clef, as the middle, and starting point, of the clef curls 

around the line which represents a G.

Raising or lowering the note from that point moves the notes up or down the musical alphabet:

Tip
Use mnemonics to learn the positions of the notes on the treble stave: FACE for the notes in 

the spaces and Every Good Boy Deserves Fruit for the lines:

Online games can give you more practice in learning the note names on the treble stave; try 

for example: Link 5 
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For lower pitched notes, we use the bass clef, and this is commonly 

seen in music for the left hand of the piano, low male voices and bass 

instruments such as the cello, double bass and bassoon. The bass clef 

is an F clef, as the clef begins on the F line, which is also the line that 

runs in between the two dots. 

Tip
For the bass clef note positions, these mnemonics may help:  All Cows Eat Grass for the 

notes in the spaces and Grizzly Bears Don’t Fly Airplanes for the lines:

For practice in identifying bass clef notes, try this online quiz: 

Link 6 

Exercise 5
Clefs are an important aspect of notated music, since without them it is impossible to tell 

how high or low a note is. You will need to include them in any music you write down.

Practice drawing both treble and bass clefs. You may find you need to do a few examples of 

each (and particularly the treble clef ) before it becomes easy to draw well. 

For the treble clef, begin on the G line and draw a spiral outwards, so that the top touches 

the line above and the bottom touches the line below. As you reach the left hand side of 

your starting point, begin to move in slight a diagonal which goes up towards the right, 

until you reach the top line of the stave. Create a loop at the top, and draw a vertical line 

down through the middle of the spiral and make a hook at the bottom under the stave.

For the bass clef, begin at the F line and move round in an arc from top to bottom. Don’t 

forget the two dots around the F line at the end!
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The Grand Staff
Instruments which are capable of covering a wide pitch range, as well as playing many notes 

at a time, such as the piano or harp, use both clefs together in the Grand Staff/Stave. Here the 

two staves are joined by a curved bracket on the left hand side, indicating that both are to be 

played together. To illustrate this, and to see how the notes flow from the bass to treble clef, 

here is the piano keyboard against the grand staff:

At the overlap of the two staves, you can see two notes, indicated by an arrow. These notes 

are exactly the same pitch. This is Middle C and is the C closest to the middle of the piano 

keyboard. Middle C lies below the treble stave and above the bass stave. In both clefs this note 

lies outside of the main notes of the stave, and is written with a small line going through it. This 

is called a ledger line.

There is an audio file of Example 7 in the course resources.

Ledger Lines
As we have seen, middle C is written on an extension of the stave called a ledger line. These 

ledger lines can be extended above and below the range of the stave as follows:

Ledger lines can also go further than these, extending a long way from the original stave, as is 

the case with an instrument such a flute that has a wide and high range.

The lower (last 5) notes in the treble clef example above translate to the following notes in bass 

clef (note the position of middle C in each example). These notes sound at exactly the same pitch. 

Example 7
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Rests
In the same way that notes have different values, we also need to be able to show periods of 

silence in the music and these are notated using a set of symbols called rests. Below are the 

rests next to their sounding notes.

Example 9 below, which can also be found as a Sibelius file, is a passage of music with rests 

inserted. Listen to the Sibelius playback to see how the different periods of silence feel. At this 

point note one of the most important rules of notation; bars must always add up to the correct 

number of beats, dictated by the time signature, regardless of the mix of sounding notes and 

periods of rest. 

 

Example 8

Example 9
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Project 2 Recognising features in a score

Below is an extract from a piano sonata by Haydn. While some of the symbols are likely to 

be unfamiliar to you, you will notice that there are many features which you are now able to 

identify.

Download the score from IMSLP via the following link:

Link 7

The extract shown above is the first line of the piece. On your copy, either on the computer or 

on a print-out of the first page, annotate the following features:

1. Treble Clef

2. Bass Clef

3. Grand stave

4. Bracket

5. Ledger Line

6. The note B above middle C

7. The note G below middle C

8. Time Signature

9. A quaver

10. A crotchet

11. A quaver rest

How many beats in the bar are there?

Find a recording of this sonata online using a search engine. There are many sources of online 

recorded music, such as YouTube, SoundCloud and Spotify, and you can often also access 

extracts of recordings from CD sales pages. 

Example 10: Piano Sonata No 21 in C by Joseph Haydn, 1st Movement
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Tip
When using the internet as a source for recordings, try to avoid the temptation of just 

listening to the first example you find. Make a note of who the performer is, and try to find 

out a little about them, their reputation, their training and their particular musical interests. 

At a time when anyone can post their recordings online, developing a sense of quality 

control is an important part of learning about music. Try to include some notes about well- 

known performers on a range of instruments in your listening and learning log.

Listen to the beginning of the Sonata. Can you hear the beat? Try to tap along as you listen. 

What is the mood of the music? Is it fast or slow? How does it make you feel? Does the 

composer use mainly high notes, or low notes or a mixture of both? Are there lots of chords, 

or is each hand only playing one note at a time? Do you like it? Why? Write down your 

responses to the music in your listening log.
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Project 3 Pitch

Start a new score in Sibelius using a Treble Staff. This can be done by using the following:

(New Score > Treble Staff > Create on Quick Start menu, or via File > New)

Choose a time signature of 3 or 4 crotchets in a bar.

Write a short melody of 4 or 8 bars, using the notes C, D, E, F, G, A and B. Start and finish on a C, 

and include a mixture of notes and rests.

To input notes, select the note value on the keypad, and click on the stave on the relevant line 

or space. If you find that you have entered the wrong pitch you can alter it using the up and 

down arrow keys on your computer. You can also enter notes using your computer keyboard by 

using the note names A to G, or by dragging with the mouse. 

Mistakes can be corrected by using the backspace key, or by clicking and deleting. To stop or 

start entering notes at any point, use the shortcut key ‘N’ on your keyboard or move between 

notes with the right and left arrow keys. You can also use the Escape key to stop entering notes 

and to clear the selection. 

You can switch between note values whilst entering data by using the keypad, as you did 

earlier. Sibelius will sound the notes as you put them in and you can also use Sibelius to play 

back what you have entered so far by using the Play functions learnt earlier. 

Note: Although Sibelius works out rests automatically, do not rely on the groupings of 

the rests. They should follow the same principle as notes, grouping beats together.
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Dotted notes and ties
Sometimes it is necessary to produce a note that is longer or shorter than a whole number of 

beats. There are two main ways to do this. Firstly dotted notes; by adding a dot after the note, 

you can increase the length by half as much again. So, a crotchet (1 beat) becomes a dotted 

crotchet (1 ½ beats), a minim (2 beats) becomes a dotted minim (3 beats) and so on. Rests can 

also be dotted and you can find a table of these notes for your reference below. Dots can be 

added to notes in Sibelius using the Keypad.

Look back at the Haydn example to see dotted semiquavers used in the context of a melody 

line. Listen to the opening of the piece again and pay particular attention to the dotted 

rhythms.

A tie is a line that lets you join together any number of different note values of the same pitch. 

This means that you can extend a note between beats, or across barlines, or even several bars at 

a time to continue a note for much longer:

In Example 12, the first note (G) is tied to the second note creating a note that lasts 2½ beats 

(minim + quaver).

In bar two, the last note (A) is tied to the next note in the following bar creating a note that lasts 

6 beats (minim + semibreve). 

Finally, the notes (G) in bars 4 and 5 are tied together creating a note that lasts 8 beats 

(semibreve + semibreve).

Example 11 

Example 12 
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Ties, Dotted Notes and Groupings
It is important to note that ties and dotted notes are used in different situations.  

Dotted notes should be used when the notes fit within a standard beaming group, and follow 

the rules of beaming used in standard notation. Therefore they can only be used within a bar, 

and should not be used to cross the middle of a bar in four-four. 

Ties can be used to go against the beaming groups, so can join together different beamed 

groups and can cross barlines. They should not be used where it would be appropriate to use a 

dotted note.

In the first two examples, dotted notes are appropriate as they do not cross the beaming 

groups (as quavers may be joined in groups of four or two in a bar of 2/4).

Music written in four-four (4/4) time, such as the final example, is usually beamed in two distinct 

groups of two beats. This means that a tie must be used instead of a dotted rhythm to connect 

a longer note over the centre of the bar.  Compare the correct and incorrect versions, and notice 

the additional clarity of beats in the correct one. 

More about groupings can be found Chapter 5 of the AB Guide to Music Theory - Part 1.

Example 13
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Project 4 Answering Rhythms

The rhythmic structure of a piece is an important way of creating balance and direction in a 

composition. In this project, you will begin to develop your sense of structural balance through 

the composition of answering rhythms.

If you open Project 4 in Sibelius you should find three unfinished rhythms:

 

Try tapping, or clapping, the rhythms before you listen through in the Sibelius file. Play it 

through several times to help familiarise yourself with the motif. 

Like speech, music is divided into phrases, and these can often be structured with a question/

answer dialogue. Practicing the creation of these phrases is a useful way to begin developing 

your compositional ideas. Your answering rhythm may contain elements of the given ‘question’, 

and to balance the question well it should be a similar length. To get a sense of closure at the 

end, a longer note might be appropriate.

 

Come up with answers to the rhythmic questions given.

After you have composed your rhythms, write a paragraph or two about how you approached 

the project and how well you think it went. Save this as ‘Project 4 Commentary’; you will need 

to send it to your tutor along with Assignment 1.

44

34

44
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Project 4.sib
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Musical terms and direction
In addition to pitch and rhythm, musical scores provide information about the speed, style 

and mood of the music in order for performers to be able to recreate the music in the way the 

composer imagined. 

Many of these terms and directions are written in Italian, but they are also written in other 

languages, including English, French and German. As you work through the course you will 

gradually build up your specialist musical vocabulary, which you can use in your listening logs 

to help describe the music you hear.

Tempo
Tempo is an important term, and is used to describe the speed at which a piece should be 

played (e.g. at a fast or a slow tempo). It can also be used to return a piece of music to the 

original speed after slowing down or speeding up, through the term ‘a tempo’ (in time). Terms 

that concern speed are generally written above the stave. 

Accelerando (accel.) gradually getting quicker

Adagio slow

Allegretto fairly quick

Allegro quick

Andante at a walking pace

Lento slow

Moderato moderately

Rallentando (rall.) gradually getting slower

Ritardando (rit. or ritard.) gradually getting slower

Ritenuto (rit. or riten.) held back

Tempo speed/time

To add these terms in Sibelius, right-click on any area of the score, select Text and then Tempo, 

left-click on the score where you want to add the tempo (a cursor will then appear) and then 

either type what you want or right click to be given a list of common terms to choose from. 

Some markings which indicate a gradual change in tempo (such as rit and accel) might also 

need a dotted line to indicate how long they last for. These can be found in the Lines section of 

Sibelius. Right-click on the score and select Line, or use the Notations tab and then Lines. After 

selecting the line style you can then left-click to place it on the score, and also hold and drag 

the sign to elongate it. This has the function of setting where the speed change will start and 

end. 
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Dynamics
Dynamics are terms which indicate volume. Using these terms, composers are able to create 

a hierarchy between parts, allowing the main melodic material to be played louder than 

accompaniment figures, and creating contrast between loud and soft sounds.

forte (f ) loud

fortissimo (ff) very loud

mezzo forte (mf) moderately loud

mezzo piano (mp) moderately quiet

piano (p) soft

pianissimo (pp) very soft

crescendo (cresc.) gradually getting louder

descrescendo (decresc.) gradually getting softer

diminuendo (dim.) gradually getting softer

Terms concerning dynamics are generally placed below the stave, as shown below.

These marks can be added by right-clicking on the score and selecting Text and then 

Expression, left clicking on the score to place the cursor, and then right-clicking for options. 

There are also additional signs for gradually getting louder or quieter, informally called 

‘hairpins’, that can be placed in the score using the Lines menu. They can also be added using 

shortcuts, H for crescendo and Shift+H for diminuendo. 

Tip
You can also preselect the length of these 

markings by highlighting the section to cover 

before using the shortcuts.
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Other terms and signs
A wide range of other terms and signs appear in music, for example to describe mood, style, 

articulation, or to indicate that a section of music is to be repeated. Examples of some of these 

are shown below.

Cantabile in a singing style

Da capo (D.C.) repeat from the beginning

Dal segno (D.S.) 
repeat from the sign ( ��% )

Fine the end, finish (indicating where to 

stop)

Legato smoothly

Poco a little

Staccato (stacc.) short, detached

Other markings are more easily shown on a passage of music. Each symbol is explained in the 

numbered list below.

1. At the start of the piece and at every subsequent change of tempo, the metronome mark 

specifies exactly the intended speed in beats per minute. In this example, the crotchet 

shows the type of beat, and the number tells us there are beats per minute. Above the stave 

is the metronome mark which is included to exactly specify the intended speed which, in 

this example, is 98 crotchet beats per minute (BPM). 

2. Notice the difference between the first and last pairs of notes in bar 1. The first pair have 

a smooth arced bracket between them (not to be confused with a tie). This is a slur which 

tells the performer to play the notes smoothly (legato). 

3. The second pair have dots under them, which means to play the notes short and detached 

(staccato). 

4. At the end of bar 2 there is a pause mark U which means to hold the note longer. 

5. In bar 3 the first pair of notes has an 8vb (ottava bassa) line under them, meaning to play 

those notes an octave below what is written. 

6. Similarly, the second pair has an 8va (all’ ottava) line above, meaning to play the notes an 

octave above what is written. 

7. In bar 4 the first two notes have accent marks over them; play them with more emphasis 

than normal. 

Example 14
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8. Finally at the start of bar 3 and the end of bar 4 you have thick black double barlines with 

dots inside. These are repeat marks which tell the performer that when they have reached 

the end of bar 4 they must go back to the start of bar 3 again and repeat that section. 

Example 14 can be found as an audio and Sibelius file so that you can follow the markings in 

the music. 

• All these markings can be added to scores in Sibelius using either the Lines function or via 

the Keypad. 

• D.S., D.C. and Fine and other repeat terms can be found using right-click Text > Other 

System Text > Repeat (D.C. etc.). 

• Slurs can also be added by highlighting the area to bracket and pressing S. 

• You can also highlight and copy and paste sections of music using Ctrl+C and Ctrl+V. 

A full list of shortcuts can be found online in the Sibelius handbook: Link 8 and also a summary 

here: Link 9
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Special subject investigation: An Introduction
Academic research, presented in written form, for example in essays, critical reviews and 

dissertations, is an integral part of the communication of ideas at degree level. Research can 

lead to a fascinating journey of discovery and a detailed knowledge of a particular aspect of the 

subject. 

Your Special Subject Investigation (SSI) is an opportunity to gain a deeper knowledge of an area 

of music, where you will develop your writing skills under the guidance of your tutor. The SSI is 

a 1000 word essay on a topic of your choice, which you will submit at the end of the course as 

Assignment 5. 

Research sources
To be able to research successfully, you need to know where to look for relevant information. 

Books and the internet are an obvious starting point, but others are also worthy of exploration.  

Newspapers, radio programmes, interviews, documentaries, sleeve notes, recordings, scores, 

and even paintings and other iconography can give you clues to particular research topics. 

Libraries
Local libraries may have limited specialist musical material, but in addition to books, many 

will have access to recordings and some archive material such as newspapers and journals. 

Bigger city libraries will have a wider selection of materials and many university libraries will 

allow members of the public to join. In these you will find a large range of books, journals, 

dissertations and academic scholarship.

Exercise 6 Choosing a subject
First, you must choose a topic. Your SSI can focus on any area of Western Art Music that 

appeals to you, but must be written in an academic style, and based on research and critical 

engagement rather than on personal opinion.

Whilst the choice of the subject is very much your own, it must be chosen carefully. It might 

be, for example, a style of music, a period of music, a composer, a conductor or performer, 

an instrument or family of instruments. 

Your tutor will advise you about the suitability of your choice, but to begin with, do some 

preliminary research to narrow down your possible subject areas to two of three possible 

topics.
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Internet
The internet has revolutionised the way that information is stored and shared, and there are 

many websites that will help you in your research. 

Always keep a list of the sites that you visit as these will go towards your bibliography at the 

end of the final assignment. Some useful types of website:

• Search engines (such as Google.com or Bing.com): Browser searches return valuable 

potential avenues of research to follow up.

• Publishers’, composers’, conductors’, ensembles’ and musicians’ websites: These are full 

of first-hand information, such as biographies, commissions, activities, blogs and links to 

further areas of research.

• Academic search engines such as Google Scholar (scholar.google.co.uk) and databases such 

as JSTOR.org contain scholarly and academic papers that are not generally found through 

other online sources.

• Library websites - many county library services also allow online access to articles and other 

external partner institutions like the Naxos music service.

• TV and radio station websites – these will often contain a number of ‘on demand’ services 

with interviews, documentaries and live performances. YouTube, Vimeo and other video 

streaming services are also often a good source of media material.

• Online score libraries - websites such as the Petrucci music library (www.imslp.org) contain 

many thousands of scores that will enable you to study scores that are out of print or very 

hard to find.  

Tip
Check your sources! As with online recordings, it is important to develop a sense of quality 

control with your use of online written sources. Try to find out who wrote the material you 

are reading and what their authority is. Can you trust that what they are saying is accurate?

Although Wikipedia may give you a basic outline of information, as it is not fully 

academically referenced, it must be avoided when referencing in your essays. It is an open 

and editable resource, written, edited and moderated by a large number of users, often 

anonymously, so, although entries can be exceptionally helpful, they can also contain 

mistakes or misleading and incorrect information. Use such a website as a starting point 

rather than as an authoritative resource. 



46   Foundations Music

Other Sources

Shops

Old book stores can be very useful for tracking down interesting information, if you have the 

time and patience to browse, or get to know the shop owner who may well be able to help you 

better than you think! Charity shops are also another goldmine of inexpensive second hand 

books. Some specialise in books, or in music, and have some fascinating collections that may 

also come in useful.

Recording liner notes

Liner notes are often full of useful information written by specialists. Always reference the 

recordings and the name of the author of the article using the Harvard referencing method 

(more of this in Part 2 and in Appendix D).

TV and Radio

There are potentially a large number of radio and TV programmes and interviews that may be 

of use to you. These can be very well researched and supply the relevant information in sections 

that you can readily digest. Often broadcasters have websites that enable you to listen or watch 

programmes again, such as the BBC’s iPlayer (www.bbc.com/iplayer). 

People

Don’t forget that research can also come in the form of undertaking your own interviews with 

people closely related to the topic you are researching. For example, you might be able to 

make contact with a living composer, or the performer who premiered a particular piece, or 

on a leading scholar in a particular area. Remember if you are approaching these people that 

they may not reply immediately, so factor a little extra time into your research, and always treat 

any expert you approach with respect, and observe internet etiquette at all times if contacting 

them through social networking or email. Introduce yourself and explain a little bit about the 

project, and don’t expect that everyone you ask will be in a position to give you some of their 

time.
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Assignment 1 

Replicating a piano piece using Sibelius

Before published music was widespread, composers would often ask their students to make 

handwritten copies of scores as a way of learning the music and understanding the teacher’s 

style. In some cases, these student copies are the only existing manuscripts of individual works, 

and we have been able to learn much from them about the music of the past.

In this assignment, you will practice your Sibelius skills by replicating an existing piece of piano 

music. On the following page you will see a 20 bar piece for piano that you will replicate from 

scratch. 

Aim to get as close as possible to the original. Don’t forget the time signature, tempo and 

dynamic markings, title and all other details, paying particular attention to the pitches and 

lengths of notes. 

This assignment draws together all the Sibelius skills that you have learnt so far.

Tip
To get started you must create a new score for piano, either using the options on the Quick 

Start menu or via File > New. You will find Piano under Solo Instruments. Note: You can also 

add/remove instruments within a score using the functions on the Home tab. 

Save this file as ‘Assignment 1’. Next, write a short explanation of how you tackled this 

project, reflecting on anything you found difficult, or easy. Save this as ‘Assignment 1 

commentary’. You will need to send both files to your tutor.
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You have reached the end of Part 1 of this course. Now is the time to compile your work to send 

to your tutor for feedback and guidance.

Along with your Assignment 1 work, you should also send your projects from Part 1 of the 

course, and links to your listening and learning logs or copies of the files. Submit the music 

files as Sibelius files and text files in word or PDF format. You can send all of these as email 

attachments (either as individual files or in a ZIP file), or send via Google Drive or the OCA 

Student website.

Remember to check with your tutor in advance what version of Sibelius your files should be 

sent in. If it is an earlier version than yours you can export your file in different versions. Simply 

open your project and then File > Export > Previous Version where you can choose which 

to save as. It is always a good idea at this point to add the version number to your file name 

(i.e. ‘Project 6 - Sibelius 7’) so that you can keep track of the different files easily. Note: once 

you have exported a file to an earlier version, do not open this new version before sending, as 

Sibelius will automatically convert it back to the version you are using.

You can expect to receive feedback from your tutor within 2-3 weeks. In the mean time, you can 

continue to Part 2 but please don’t submit the next assignment until you have heard from your 

tutor.


